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ABSTARCT

Fire monitors and sprayers are an amiable and controllable high-capacity water jet used to

deal with large fires. Unlike Fire extinguishers, Fire Monitors are permanently installed

and cannot be moved. While traditional fire monitors systems need a human operator to

change the direction of the water jet and aim it appropriately, this fire monitor has been

equipped with RF control. Thereby allowing the user to operate it from a safe distance.

The system makes use of a Motor coupled with a powerful sprayer motor with piping

system. Another motor are used to control the nozzle direction movement. The user may

use a wireless remote to transmit movement commands. The receiver circuitry mounted on

system receives users commands and operates the motors to achieve desired motion. Also,

the receiver operates the pump motor to start and stop the spray. The sprayer nozzle can

also be adjusted to adjust the water spray outlet. The sprayer mechanism is built to operate

in 360 Degree water spray coverage.
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CHAPTER 1

INTRODUCTION

1.1 Introduction
Fire hazards are a common phenomenon in developing countries like India causing loss of

lives and property every year. According to the India Risk Survey (IRS) 2018, fire

outbreak is the third most serious threat to business continuity and operations. Accidents

from fires are alarming and devastating So, to minimize losses resulting from accidents

and save lives, Fire extinguisher robots will play a vital role. Another aspect is related to

the firemen involved in these accidents – they risk their lives while rescuing the victims.

The location of the fire accident is important – e.g., chemical mills, garment factories, gas

and petrol stations, as it affects the target area including surroundings. This type of

accident results in loss to lives, and pollutes the environment. While the government and

other regulatory agencies have prescribed fire safety standards and measures, execution

and vigilance remain important issues.

Robotics: Robots are automated devices that are capable of performing tasks in an efficient,

cost-effective, and accurate manner compared to humans. It has grown in popularity as

technology has advanced, minimizing human intervention. Mechatronics: Robot

development consists of hardware, electronics and programming to automate our daily

tasks and to make or life easier using the concept of mechatronics. The Firefighting robot

that is presented in this paper focuses on providing remote maneuvering capability using a

programmable micro-controller ESP 8266 controlled through nrf, detect the fire-affected

areas using a flame sensor and then letting the user manually control the robot to douse the

fire using a water pump connected to a water storage tank.

1.2 Problem Statement

Fire outbreaks are known to cause significant loss of life (victims and rescuers) and

property. Due to high temperature and presence of potentially hazardous material fire-

fighting robots will be useful for extinguishing fire, particularly in places where fire-men

cannot reach and work. It can thus reduce human injury from a burning fire.
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1.3 Objectives
The objectives of this project are:

 To study about 360° Rotating Fire Protection System.

 To implement a Fire Protection System.

 To send an alert in gate mane phone by the use of GSM Module.

 Manual control system practice.

 To test the performance of the system.

1.4 Methodology

Our used methodology for the project:

 Creating an idea for the design and construction of “360° Rotating Fire

Protection System”. And designing a block diagram & circuit diagram to

know which components we need to construct it.

 Collecting all the components and programming the micro-controller to control

our desired system.

 Setting up all the components in a PCB board & soldering. Then assembling all

the blocks in a board and finally running the system to check if it actually

works or not.

1.5 Structure of the Project

This Project is organized as follows:

Chapter 1 Introduction:The first chapter contains the statement of the introduction, our

background study for the project, problem statement, objectives of the study and the

project outline.

Chapter 2 Literature Review: The chapter two contains our introduction, literature review

part.
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Chapter 3 Hardware and Software Analysis:Chapter three describes the theoretical model.

Here we mainly discuss about proposed system Hardware and software development of

our project etc.

Chapter 3 Methodology:Chapter three describes the theoretical model. Here we mainly

discuss about proposed system architecture in details with having block diagram, circuit

diagram, structural diagram, project working principle, complete project image etc.

Chapter 4 Result and Discussion:Chapter four deals with the result and discussion and

discuss about our project advantages and application.

Chapter 5 Conclusion:Chapter five all about our project conclusion and future scope.
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CHAPTER 2

LITERATURE REVIEW

2.1 Introduction
In this section topics related to 360° Rotating Fire Protection System are included. .

The references are summarized below.

2.2 Literature Review

In today’s era firefighting in hazardous locations is a difficult real-life problem. Many

researchers are working on Mechatronics, Internet of Things (IoT) driven techniques for

firefighting robots and have developed innovative solutions.

Tawfiqur Rakib, M. A. Rashid Sarkar proposed a firefighting robot model which consists

of a base platform made up of ‘Kerosene wood’, LM35 sensor for temperature detection,

flame sensors to detect the fire and a water container of 1 litre capacity which is made up

of a strong cardboard that makes it water resistant. The robot has two wheels for its

movement. [1]

Saravanan P., Soni Ishawarya proposed a model which uses Atmega2560 micro-controller

and in which the robot is divided into three basic units according to their functions which

are as locomotive unit, fire detecting unit and extinguishing unit. Each unit performs their

task in order to achieve the desired output of extinguishing fire. The locomotive unit is

used for the movement of the robot and to avoid the obstacles with the help of four IR and

four ultrasonic sensors. The fire detecting unit is used to detect fire using LDR and

temperature sensor. The extinguishing unit is used to extinguish the fire using water

container and BLDC motor. The robot also has a Bluetooth module that is connected with

the smartphones in order to navigate it in the proper direction. [2]

Boo Siew Khoo demonstrates the Fire Droid, an automated fire extinguisher robot that can

detect and extinguish flames. When a fire breaks out in a home, the fire-fighting robot will

be able to detect the flame and proceed to the source of the fire. Water is pumped out of

the water tank after the fire position is secured and the flame distance is calculated, hence

dousing the fire. [3]
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H.P. Singh developed the control system for a mobile autonomous industrial firefighting

robot. The paper demonstrates the creation and design of firefighting robots with a wide

range of capabilities. Two optically separated D.C. engines are housed within the structure.

The robot transforms data from infrared sensors in a variety of ways, from simple to

complex. There are five infrared sensors in use. Two sensors control the robots' movement,

while the other three are used to detect fire. A D.C water syphon and a water compartment

are included in the douser. The primary goal of the paper is to identify and suffocate fire

flare-ups. This infrared sensor serves as an information sensor, detecting infrared beams

emitted by the fire. The extinguishing mechanism is controlled by the microcontroller. [4]

This project entitled “Design and Fabrication of Fire Fighting Autonomous Robotic

System Equipped with Sensitive Sensors for Fire Alarm and Detection, Avoidance

Behaviour Mechanism and SMS Messaging Capability”. The title was based on the

functions and objectives of the study. However, this project was similarly alike to other

robots but this innovative robot was the researchers own idea. The features were pondered

by the researchers technically focusing on the components contributions when assembled

as one robot. The Design and Fabrication of Fire Fighting

Autonomous Robotic System Equipped with Sensitive Sensors for Fire Alarm and

Detection, Avoidance Behavior Mechanism and SMS Messaging Capability has additional

features that make it unique to others. It was installed with an alarm system that notifies

the owner that flame has occurred. Moreover, it has an auxiliary function like ultrasonic

sensor, flame sensor and a smoke sensor that detects the flame combustion. Robot is a

machine that resembles a human being and mimics various complex tasks. Now, let us

have a good look at existing firefighting robots. The following robots below are the

characteristic of the previous robot that have been similar with this robot project and used

in the literature review

2.3 Summary
We try to do this project by reading the above literature, and we have been able to make

our project successful by reducing the mistakes of last year's project.
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CHAPTER 3

HARDWARE AND SOFTWARE ANALYSIS

3.1 Introduction
This Project has worked on two things, Hardware and Software. Here we will discuss about

our project hardware and software details.

Hardware

 Arduino Nano

 Arduino Pro Mini

 Servo Motor

 NRF Receiver

 Motor Driver

 SMPS

 Relay

 High Speed Pump Motor

 Nozzle

3.2 Arduino Nano

Arduino is an open source electronics prototyping platform based on flexible, easy-to-use

hardware and software. It's intended for artists, designers, hobbyists, and anyone interested

in creating interactive objects or environments. Arduino can sense the environment by

receiving input from a variety of sensors and can affect its surroundings by controlling

Lights, motors, and other actuators.

Figure 3.1: Arduino Nano
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The microcontroller on the board is programmed using the Arduino programming

language (based on Wiring) and the Arduino development environment (based on

Processing). Arduino projects can be stand-alone or they can communicate with software

on running on a computer (e.g. Flash, Processing, Maxims’). Arduino Nano is a surface

mount breadboard embedded version with integrated USB. It is a small, complete, and

breadboard friendly component.

Figure 3.2: Arduino Nano Schematic Diagram

Nano’s got the breadboard-ability of the Boarding and the Minibus with smaller footprint

than either, so users have more breadboard space. It’s got a pin layout that works well with

the Mini or the Basic Stamp (TX, RX, ATN, and GND on one top, power and ground on

the other). This new version 3.0 comes with ATMEGA328 which offer more

programming and data memory space. It has two layers. That make it easier to hack and

more affordable. One of the best features of Arduino Nano is, it’s easy to use, compact and

also small.

Figure 3.3: How Arduino Nano looks like
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Specifications:

 Microcontroller: Atmel ATmega328

 Operating Voltage (logic level): 5 V

 Input Voltage (recommended): 7-12 V

 Input Voltage (limits): 6-20 V

 Digital I/O Pins: 14 (of which 6 provide PWM output)

 Analog Input Pins: 8

 DC Current per I/O Pin: 40 mA

 Flash Memory: 32 KB (of which 2KB used by boot loader)

 SRAM : 2 KB

 EEPROM: 1 KB

Features:

 Automatic reset during program download

 Power OK blue LED

 Green (TX), red (RX) and orange (L) LED

 Auto sensing/switching power input

 Small mini-B USB for programming and serial monitor

 ICSP header for direct program download

 Standard 0.1 spacing DIP (breadboard friendly)

 Manual reset switch

Micro-controller IC ATmega328p

Figure 3.4: Micro-controller IC AT mega 328p
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The high-performance Microchip Pico Power 8-bit AVR RISC-based micro-controller

combines 32KB ISP flash memory with read-while-write capabilities, 1024B EEPROM,

2KB SRAM, 23 general purpose I/O lines, 32 general purpose working registers, three

flexible timer/counters with compare modes, internal and external interrupts, serial

programmable USART, a byte-oriented 2-wire serial interface, SPI serial port, a 6-channel

10-bit A/D converter (8-channels in TQFP and QFN/MLF packages), programmable

watchdog timer with internal oscillator, and five software selectable power saving modes.

The device operates between 1.8-5.5 volts. By executing powerful instructions in a single

clock cycle, the device achieves throughputs approaching 1 MIPS per MHz, balancing

power consumption and processing speed.

3.3 Arduino Pro Mini

The Arduino Pro Mini is a micro-controller board based on the ATmega168. It has 14

digital input/output pins (of which 6 can be used as PWM outputs), 6 analog inputs, an on-

board resonator, a reset button, and holes for mounting pin headers. A six pin header can

be connected to an FTDI cable to provide USB power and communication to the board.

Figure 3.5: Arduino Pro Mini

Specification

 Micro-controller ATmega168

 Operating Voltage: 3.3V or 5V (depending on model)

 Input Voltage: 3.35 -12 V (3.3V model) or 5 - 12 V (5V model)
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 Digital I/O Pins: 14 (of which 6 provide PWM output)

 Analog Input Pins: 6

 DC Current per I/O Pin: 40 mA

 Flash Memory: 16 KB (of which 2 KB used by boot loader)

 SRAM: 1 KB

 EEPROM: 512 bytes

 Clock Speed: 8 MHz (3.3V model) or 16 MHz (5V model)

Pin Out

Each of the 14 digital pins on the Pro Mini can be used as an input or output, using pin

Mode(), digital Write(), and digital Read() functions. They operate at 3.3 or 5 volts

(depending on the model). Each pin can provide or receive a maximum of 40 mA and has

an internal pull-up resistor (disconnected by default) of 20-50 kOhms. In addition, some

pins have specialized functions:

 Serial: 0 (RX) and 1 (TX). Used to receive (RX) and transmit (TX) TTL serial data.

These pins are connected to the TX-0 and RX-1 pins of the six pin header.

 External Interrupts: 2 and 3. These pins can be configured to trigger an interrupt on

a low value, a rising or falling edge, or a change in value. See the attachInterrupt()

function for details.

 PWM: 3, 5, 6, 9, 10, and 11. Provide 8-bit PWM output with the analogWrite()

function.

 SPI: 10 (SS), 11 (MOSI), 12 (MISO), 13 (SCK). These pins support SPI

communication, which, although provided by the underlying hardware, is not

currently included in the Arduino language.

 LED: 13. There is a built-in LED connected to digital pin 13. When the pin is

HIGH value, the LED is on, when the pin is LOW, it's off.
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The Pro Mini has 6 analog inputs, each of which provide 10 bits of resolution (i.e.

1024 different values). Four of them are on the headers on the edge of the board;

two (inputs 4 and 5) on holes in the interior of the board. The analog inputs

measure from ground to VCC. Additionally, some pins have specialized

functionality:

 I2C: 4 (SDA) and 5 (SCL). Support I2C (TWI) communication using the Wire

library.

There is another pin on the board:

 Reset. Bring this line LOW to reset the micro controller. Typically used to add a

reset button to shields which block the one on the board.

See also the mapping between Arduino pins and ATmega168 ports.

Figure 3.6: Arduino Pro Mini Pin Out

3.4 Switch Mode Power Supply (SMPS)

A switched-mode power supply (switching-mode power supply, switch-mode power

supply, switched power supply, SMPS, or switcher) is an electronic power supply that

incorporates a switching regulator to convert electrical power efficiently. Like other power

supplies, an SMPS transfers power from a DC or AC source (often mains power) to DC

loads, such as a personal computer, while converting voltage and current characteristics.

https://en.wikipedia.org/wiki/Power_supply
https://en.wikipedia.org/wiki/Voltage_regulator
https://en.wikipedia.org/wiki/Electrical_power_conversion
https://en.wikipedia.org/wiki/Mains_electricity
https://en.wikipedia.org/wiki/Personal_computer
https://en.wikipedia.org/wiki/Voltage
https://en.wikipedia.org/wiki/Electric_current
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Unlike a linear power supply, the pass transistor of a switching-mode supply continually

switches between low-dissipation, full-on and full-off states, and spends very little time in

the high dissipation transitions, which minimizes wasted energy. A hypothetical ideal

switched-mode power supply dissipates no power. Voltage regulation is achieved by

varying the ratio of on-to-off time (also known as duty cycles). In contrast, a linear power

supply regulates the output voltage by continually dissipating power in the pass transistor.

This higher power conversion efficiency is an important advantage of a switched-mode

power supply. Switched-mode power supplies may also be substantially smaller and

lighter than a linear supply due to the smaller transformer size and weight.

Figure 3.7: SMPS

Switching regulators are used as replacements for linear regulators when higher efficiency,

smaller size or lighter weight are required. They are, however, more complicated; their

switching currents can cause electrical noise problems if not carefully suppressed, and

simple designs may have a poor power factor.

12V 5A Industrial SMPS Power Supply – 60W – DC Metal Power Supply – Good Quality

– Non Waterproof with Aluminum casing.

 Input Voltage: AC 100 – 264V 50 / 60Hz

 Output Voltage: 12V DC, 0-5A

 Output voltage: Adjustment Range: ±20%

 Protections: Overload / Over Voltage / Short Circuit

https://en.wikipedia.org/wiki/Linear_power_supply
https://en.wikipedia.org/wiki/Dissipation
https://en.wikipedia.org/wiki/Voltage_regulator
https://en.wikipedia.org/wiki/Duty_cycle
https://en.wikipedia.org/wiki/Transistor
https://en.wikipedia.org/wiki/Power_factor
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 Auto-Recovery After Protection

 Universal AC input / Full range

 100% Full Load Burn-in Test

 Cooling by Free Air Convection

 High Quality and High Performance

 LED power supply with a metal body for hidden installation for LED lighting

 Design with Built-in EMI Filter, improve signal precision.

 Certifications: CE & RoHs

Switched-mode power supplies are classified according to the type of input and output

voltages. The four major categories are:

 AC to DC

 DC to DC

 DC to AC

 AC to AC

A basic isolated AC to DC switched-mode power supply consists of:

 Input rectifier and filter

 Inverter consisting of switching devices such as MOSFETs

 Transformer

 Output rectifier and filter

 Feedback and control circuit

The input DC supply from a rectifier or battery is fed to the inverter where it is turned on

and off at high frequencies of between 20 KHz and 200 KHz by the switching MOSFET

or power transistors. The high-frequency voltage pulses from the inverter are fed to the

transformer primary winding, and the secondary AC output is rectified and smoothed to

produce the required DC voltages. A feedback circuit monitors the output voltage and

instructs the control circuit to adjust the duty cycle to maintain the output at the desired

level.
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Figure 3.8: SMPS Circuit Design

Basic working concept of an SMPS

A switching regulator does the regulation in the SMPS. A series switching element turns

the current supply to a smoothing capacitor on and off. The voltage on the capacitor

controls the time the series element is turned. The continuous switching of the capacitor

maintains the voltage at the required level.

Design basics

AC power first passes through fuses and a line filter. Then it is rectified by a full-wave

bridge rectifier. The rectified voltage is next applied to the power factor correction (PFC)

pre-regulator followed by the downstream DC-DC converter(s). Most computers and small

appliances use the International Electro technical Commission (IEC) style input connector.

As for output connectors and pin outs, except for some industries, such as PC and compact

PCI, in general, they are not standardized and are left up to the manufacturer.

There are different circuit configurations known as topologies, each having unique

characteristics, advantages and modes of operation, which determines how the input power

is transferred to the output. Most of the commonly used topologies such as fly back, push-

pull, half bridge and full bridge, consist of a transformer to provide isolation, voltage

scaling, and multiple output voltages. The non-isolated configurations do not have a

transformer and the power conversion is provided by the inductive energy transfer.

https://www.electronicsforu.com/electronics-projects/power-factor-correction
https://www.iec.ch/about/?ref=menu
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Advantages of switched-mode power supplies:

 Higher efficiency of 68% to 90%

 Regulated and reliable outputs regardless of variations in input supply voltage

 Small size and lighter

 Flexible technology

 High power density

Disadvantages:

 Generates electromagnetic interference

 Complex circuit design

 Expensive compared to linear supplies

Switched-mode power supplies are used to power a wide variety of equipment such as

computers, sensitive electronics, battery-operated devices and other equipment requiring

high efficiency

Switch Mode Power Supply

Figure 3.9: Power Supply Connection

Linear voltage IC regulators have been the basis of power supply designs for many years

as they are very good at supplying a continuous fixed voltage output. Linear voltage

regulators are generally much more efficient and easier to use than equivalent voltage
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regulator circuits made from discrete components such a zener diode and a resistor, or

transistors and even op-amps. The most popular linear and fixed output voltage regulator

types are by far the positive output voltage series, and the 79 negative output voltage

series. These two types of complementary voltage regulators produce a precise and stable

voltage output ranging from about 5 volts up to about 24 volts for use in many electronic

circuits.

There is a wide range of these three-terminal fixed voltage regulators available each with

its own built-in voltage regulation and current limiting circuits. This allows us to create a

whole host of different power supply rails and outputs, either single or dual supply,

suitable for most electronic circuits and applications. There are even variable voltage

linear regulators available as well providing an output voltage which is continually

variable from just above zero to a few volts below its maximum voltage output.

Most D.C. power supplies comprise of a large and heavy step-down mains transformer,

diode rectification, either full-wave or half-wave, a filter circuit to remove any ripple

content from the rectified D.C. producing a suitably smooth D.C. voltage, and some form

of voltage regulator or stabilizer circuit, either linear or switching to ensure the correct

regulation of the power supplies output voltage under varying load conditions. Then a

typical D.C. power supply would look something like this:

Typical DC Power Supply

Figure 3.10: DC Power Supply Step

These typical power supply designs contain a large mains transformer (which also

provides isolation between the input and output) and a dissipative series regulator circuit.

The regulator circuit could consist of a single zener diode or a three-terminal linear series

regulator to produce the required output voltage. The advantage of a linear regulator is that
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the power supply circuit only needs an input capacitor, output capacitor and some

feedback resistors to set the output voltage.

3.5 Servo Motor

A servo motor is an electrical device that can push or rotate an object with great precision.

If you want to rotate and object at certain angles or distances, you use servo motors. It is

made by a simple motor which is driven by a servo mechanism. If the motor is DC driven

then it is called DC servo motor and if it is AC driven motor then it is called AC servo

motor. We can get a very high torque servo motor in a small and light weight package.

These are being used in various applications like toy cars, RC helicopters and planes,

robotics, machines etc.

Figure 3.11: Servo Motor

Servo motors are rated at kg / cm (centimeters per kilogram). Most hobby servo motors are

rated at 3 kg / cm or 6 kg / cm or 12 kg / cm. This kg / centimeter tells you how much

weight your servo motor can lift at a certain distance. For example: A 6 kg / cm servo

motor should be able to lift 6 kg if the load is suspended 1 cm away from the motor shaft,

to be less than the carrying capacity. The position of the servo motor is determined by the

electric pulse and its circuitry is placed next to the motor.

Servo Mechanism

It consists of three parts:

1. Controlled device

2. Output sensor

3. Feedback system
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All motors have three wires. Of which two will be used for the supply (positive and

negative) and one will be used for the signal transmitted from the MCU. The servo motor

is controlled by PWM (Pulse with Modulation) which provides the control wires. Has

minimum pulse, maximum pulse and repetition rate. The servo motor can rotate 90

degrees in two directions, creating its neutral position. The servo motor expects to see a

pulse every 20 milliseconds (ms) and the pulse length will determine how far the motor

rotates. For example, a 1.5 mm pulse will turn the motor to 90 °, for example, if the branch

is less than 1.5 mm shaft, it will move to 0 to, and if it is longer than 1.5 mm, the servo

will turn to 180 to.

The servo motor operates on the PWM (pulse width modulation) principle, meaning that

the angle of rotation is controlled by the duration of the pulse applied to its control pin.

Basically, the servo motor is made up of a DC motor which is controlled by a variable

resistor (potentiometer) and some gears. The high-speed force of the DC motor is

converted to torque by the gears. We know that work = force x DISTANCE, less in DC

motor force and more in distance (speed) and in servo, forces are higher and distance is

less. The potentiometer server is connected to the output trench to calculate the angle and

stop the DC motor at the required angle.

Figure 3.12: Schema Diagram of servo motor

The servo motor can be rotated from 0 to 180 degrees but depending on the output it can

go up to 210 degrees. This degree of rotation can be controlled by applying an electric
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pulse of appropriate width to its control pin. Servo examines pulses every 20 milliseconds.

The 1 ms (1 millisecond) width pulse servo can rotate 0 degrees, 1.5 mm 90 degrees

(neutral position) and 2 ms pulse it can rotate 180 degrees. All servo motors work directly

with your + 5V supply rails but we need to be careful about how much current the motor

will use. If you plan to use more than two servo motors, you should design a suitable

servo solder.

3.6 L293D Motor Driver IC

The L293D is a popular 16-PinMotor Driver IC. As the name suggests it is mainly used

to drive motors. A single L293D IC is capable of running two DC motors at the same

time; also the direction of these two motors can be controlled independently.

Figure 3.13: Motor driver IC L293D

Working Process

L293D IC is a typical Motor Driver IC which allows the DC motor to drive on any

direction. This IC consists of 16-pins which are used to control a set of two DC motors

instantaneously in any direction. It means, by using a L293D IC we can control two DC

motors.
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Features

 Can be used to run Two DC motors with the same IC.

 Speed and Direction control is possible

 Motor voltage Vcc2 (Vs): 4.5V to 36V

 Maximum Peak motor current: 1.2A

 Maximum Continuous Motor Current: 600mA

L293D Pin Configuration

Table 02: Motor Driver Pin out

Pin Number Pin Name Description

1 Enable 1,2
This pin enables the input pin Input 1(2) and

Input 2(7)

2 Input 1
Directly controls the Output 1 pin. Controlled by

digital circuits

3 Output 1 Connected to one end of Motor 1

4 Ground
Ground pins are connected to ground of circuit

(0V)

5 Ground
Ground pins are connected to ground of circuit

(0V)

6 Output 2 Connected to another end of Motor 1

7 Input 2
Directly controls the Output 2 pin. Controlled by

digital circuits

8 Vcc2 (Vs)
Connected to Voltage pin for running motors

(4.5V to 36V)

9 Enable 3,4
This pin enables the input pin Input 3(10) and

Input 4(15)

10 Input 3
Directly controls the Output 3 pin. Controlled by

digital circuits

11 Output 3 Connected to one end of Motor 2

12 Ground Ground pins are connected to ground of circuit
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(0V)

13 Ground
Ground pins are connected to ground of circuit

(0V)

14 Output 4 Connected to another end of Motor 2

Use of a L293D Motor Driver IC

Using this L293D motor driver IC is very simple. The IC works on the principle of Half

H-Bridge, let us not go too deep into what H-Bridge means, but for now just know that H

bridge is a set up which is used to run motors both in clock wise and anti clockwise

direction. As said earlier this IC is capable of running two motors at the any direction at

the same time, the circuit to achieve the same is shown below.

Figure 3.14: L293D circuit Diagram

All the Ground pins should be grounded. There are two power pins for this IC, one is the

Vss(Vcc1) which provides the voltage for the IC to work, this must be connected to +5V.

The other is Vs(Vcc2) which provides voltage for the motors to run, based on the

specification of your motor you can connect this pin to anywhere between 4.5V to 36V,

here I have connected to +12V.
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The Enable pins (Enable 1,2 and Enable 3,4) are used to Enable Input pins for Motor 1

and Motor 2 respectively. Since in most cases we will be using both the motors both the

pins are held high by default by connecting to +5V supply. The input pins Input 1,2 are

used to control the motor 1 and Input pins 3,4 are used to control the Motor 2. The input

pins are connected to the any Digital circuit or micro-controller to control the speed and

direction of the motor.

Applications

 Used to drive high current Motors using Digital Circuits

 Can be used to drive Stepper motors

 High current LED’s can be driven

 Relay Driver module (Latching Relay is possible)

3.7 High Speed Pump

A pump is a device that moves fluids (liquids or gases), or sometimes slurries, by

mechanical action, typically converted from electrical energy into hydraulic energy.

Mechanical pumps serve in a wide range of applications such as pumping water from

wells, aquarium filtering, pond filtering and aeration, in the car industry for water-

cooling and fuel injection, in the energy industry for pumping oil and natural gas or for

operating cooling towers and other components of heating, ventilation and air

conditioning systems. In the medical industry, pumps are used for biochemical processes

in developing and manufacturing medicine, and as artificial replacements for body parts,

in particular the artificial heart and penile prosthesis.

Feature:

 Pump Operating Voltage: 12V - 24V

 Power: 120W Max

 Working Pressure: 160Psi (10.5 Bar) Cutoff

 Cutoff Automatic Switch

https://en.wikipedia.org/wiki/Liquid
https://en.wikipedia.org/wiki/Gas
https://en.wikipedia.org/wiki/Slurry
https://en.wikipedia.org/wiki/Water_well_pump
https://en.wikipedia.org/wiki/Water_well_pump
https://en.wikipedia.org/wiki/Aquarium_filter
https://en.wikipedia.org/wiki/Pond
https://en.wikipedia.org/wiki/Water_aeration
https://en.wikipedia.org/wiki/Car_industry
https://en.wikipedia.org/wiki/Water_cooling
https://en.wikipedia.org/wiki/Water_cooling
https://en.wikipedia.org/wiki/Fuel_injection
https://en.wikipedia.org/wiki/Energy_industry
https://en.wikipedia.org/wiki/Pumping_(oil_well)
https://en.wikipedia.org/wiki/Natural_gas
https://en.wikipedia.org/wiki/Cooling_tower
https://en.wikipedia.org/wiki/Heating,_ventilation_and_air_conditioning
https://en.wikipedia.org/wiki/Heating,_ventilation_and_air_conditioning
https://en.wikipedia.org/wiki/Medical_industry
https://en.wikipedia.org/wiki/Artificial_heart
https://en.wikipedia.org/wiki/Penile_implant


23

 Flow (MAX): 10L/min

 Pressure Adjustable Copper Head Water Spray

 Water Pressure Limit : Adjustable

 Sprayers Size : 20cm

 Spray Distance: 9 m

 Thread Diameter: 1.5cm

 Main Material: Copper, Plastic

 Power supply Voltage: 12V DC

 Power supply Current: 5A

Figure 3.15: High Speed Pump

3.8 NRF Wireless Module
The nRF24L01 is a wireless transceiver module, meaning each module can both send as

well as receive data. They operate in the frequency of 2.4GHz, which falls under the ISM

band and hence it is legal to use in almost all countries for engineering applications.
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Figure 3.16: NRF Receiver

Power

The module’s operating voltage ranges from 1.9 to 3.9V. Please keep in mind that

powering the module with 5V will most likely damage your nRF24L01+ module.Despite

the fact that the module operates at 1.9V to 3.6V, the logic pins are 5-volt tolerant, so you

do not need a logic level translator.The output power of the module can be programmed to

be 0 dBm, -6 dBm, -12 dBm, or -18 dBm. At 0 dBm, the module consumes only 12 mA

during transmission, which is less than the consumption of a single LED. And the best part

is that it consumes only 26 µA in standby mode and 900 nA in power down mode. That’s

why it’s the go-to wireless device for low-power applications.

SPI Interface

The nRF24L01+ communicates over a 4-pin SPI (Serial Peripheral Interface) with a

maximum data rate of 10Mbps. All parameters, including frequency channel (125

selectable channels), output power (0 dBm, -6 dBm, -12 dBm or -18 dBm), and data rate

(250kbps, 1Mbps, or 2Mbps), can be configured through the SPI interface. The SPI bus

uses the concept of a master and a slave. In most of our projects, the Arduino serves as the

master and the nRF24L01+ module serves as the slave.
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Technical Specifications

Here are the specifications:

Frequency Range 2.4 GHz ISM Band

Maximum Air Data Rate 2 Mb/s

Modulation Format GFSK

Max. Output Power 0 dBm

Operating Supply Voltage 1.9 V to 3.6 V

Max. Operating Current 13.5mA

Min. Current(Standby Mode) 26µA

Logic Inputs 5V Tolerant

Communication Range 800+ m (line of sight)

3.9 The Smoothing Capacitor

When there is a potential difference across the conductors (e.g., when a capacitor is

attached across a battery), an electric field develops across the dielectric, causing positive

charge (+Q) to collect on one plate and negative charge (-Q) to collect on the other plate.

If a battery has been attached to a capacitor for a sufficient amount of time, no current can

flow through the capacitor. However, if an accelerating or alternating voltage is applied

across the leads of the capacitor, a displacement current can flow.
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Figure 3.17: Capacitor

An ideal capacitor is characterized by a single constant value for its capacitance.

Capacitance is expressed as the ratio of the electric charge (Q) on each conductor to the

potential Difference (V). The SI unit of capacitance is the farad (F), which is equal to one

coulomb per volt (1 C/V). Typical capacitance values range from about 1 pF (10−12 F) to

about 1 mF (10−3 F). The capacitance is greater when there is a narrower separation

between conductors and when the conductors have a larger surface area.

In practice, the dielectric between the plates passes a small amount of leakage current and

also has an electric field strength limit, known as the breakdown voltage. The conductors

and leads introduce an undesired inductance and resistance. Capacitors are widely used in

electronic circuits for blocking direct current while allowing alternating current to pass. In

analog filter networks, they smooth the output of power supplies. In resonant circuits they

tune radios to particular frequencies. In electric power transmission systems, they stabilize

voltage and power flow.

The full-wave bridge rectifier however, gives us a greater mean DC value (0.637 Vmax)

with less superimposed ripple while the output waveform is twice that of the frequency of

the input supply frequency. We can improve the average DC output of the rectifier while

at the same time reducing the AC variation of the rectified output by using smoothing

capacitors to filter the output waveform. Smoothing or reservoir capacitors connected in

parallel with the load across the output of the full wave bridge rectifier circuit increases the

average DC output level even higher as the capacitor acts like a storage device as shown

below. Too low a capacitance value and the capacitor has little effect on the output
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waveform. But if the smoothing capacitor is sufficiently large enough (parallel capacitors

can be used) and the load current is not too large, the output voltage will be almost as

smooth as pure DC.

Figure 3.18: The Smoothing Capacitor with Full Bridge Rectifier

3.10 Resistor
A resistor is a passive two-terminal electrical component that implements electrical

resistance as a circuit element. Resistors act to reduce current flow, and, at the sometime,

act to lower voltage levels within circuits. Resistors may have fixed resistances or variable

resistances, such as those founding thermostats, visitors, trimmers, photo resistors,

hamsters and potentiometers. The current through a resistor is in direct proportion to the

voltage across the resistor's terminals. This relationship is represented by Ohm's law.

Figure 3.19: Resistor
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Theory of operation:

The behavior of an ideal resistor is dictated by the relationship specified by Ohm ‘slaw:

V = I.R

Ohm's law states that the voltage (V) across a resistor is proportional to the current (I),

where the constant of proportionality is the resistance (R).

Equivalently, Ohm's law can be stated:

I = V/R

This formulation states that the current (I) is proportional to the voltage (V) and inversely

proportional to the resistance (R). This is directly used in practical computations. For

example, if a 300 ohm resistor is attached across the terminals of a12 volt battery, then a

current of12 / 300 = 0.04 amperes flows through that resistor.

3.11 Arduino Software

The digital microcontroller unit named as Arduino Nano can be programmed with the

Arduino software IDE. There is no any requirement for installing other software rather

than Arduino. Firstly, Select "Arduino Nano from the Tools, Board menu (according to the

microcontroller on our board). The IC used named as ATmega328 on the Arduino Nano

comes pre burned with a boot loader that allows us to upload new code to it without the

use of an external hardware programmer.

Communication is using the original STK500 protocol (reference, C header files). We can

also bypass the boot loader and programs the microcontroller through the ICSP (In Circuit

Serial Programming) header. The ATmega16U2 (or 8U2 in the rev1 and rev2 boards)

firmware source code is available. The ATmega16U2/8U2 is loaded with a DFU boot

loader, which can be activated by:

On Rev1 boards: connecting the solder jumper on the back of the board (near the map of

Italy) and then resetting the 8U2. On Rev2 or later boards: there is a resistor that pulling

the 8U2/16U2 HWB line to ground, making it easier to put into DFU mode.
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The Arduino Nano is one of the latest digital microcontroller units and has a number of

facilities for communicating with a computer, another Arduino, or other microcontrollers.

The ATmega328 provides UART TTL at (5V) with serial communication, which is

available on digital pins 0 -(RX) for receive the data and pin no.1 (TX) for transmit the

data. An ATmega16U2 on the board channels this serial communication over USB and

appears as a virtual com port to software on the computer. The '16U2 firmware uses the

standard USB COM drivers, and no external driver is needed. However, on Windows,

an .in file is required. The Arduino software includes a serial monitor which allows simple

textual data to be sent to and from the Arduino board.

The RX and TX LEDs on the board will flash when data is being transmitted via the USB-

to-serial chip and USB connection to the computer (but not for serial Communication on

pins 0 and 1). A Software Serial library allows for serial communication on any of the

Nano's digital pins. The ATmega328 also supports I2C (TWI) and SPI communication.

The Arduino software includes a Wire library to simplify use of the I2C bus. Arduino

programs are written in C or C++ and the program code written for Arduino is called

sketch. The Arduino IDE uses the GNU tool chain and AVR Lab to compile programs,

and for uploading the programs it uses argued.

Figure 3.20: Arduino Software Interface IDE
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Writing Sketches

Programs written using Arduino Software (IDE) are called sketches. These sketches are

written in the text editor and are saved with the file extension. ino. The editor has features

for cutting/pasting and for searching/replacing text. The message area gives feedback

while saving and exporting and also displays errors. The console displays text output by

the Arduino Software (IDE), including complete error messages and other information.

The bottom righthand corner of the window displays the configured board and serial port.

The toolbar buttons allow you to verify and upload programs, create, open, and save

sketches, and open the serial monitor.

Burn Bootloader

The items in this menu allow you to burn a boot loader onto the microcontroller on an

Arduino board. This is not required for normal use of an Arduino or Genuino board but is

useful if you purchase a new ATmega microcontroller (which normally come without a

boot loader). Ensure that you've selected the correct board from the Boards menu before

burning the boot loader on the target board. This command also set the right fuses.

Uploading

Before uploading your sketch, you need to select the correct items from the Tools > Board

and Tools > Port menus. The boards are described below. On the Mac, the serial port is

probably something like /dev/tty.usbmodem241 (for an Uno or Mega2560 or Leonardo) or

/dev/tty.usbserial-1B1 (for a Duemilanove or earlier USB board), or

/dev/tty.USA19QW1b1P1.1 (for a serial board connected with a Keyspan USB-to-Serial

adapter). On Windows, it's probably COM1 or COM2 (for a serial board) or COM4,

COM5, COM7, or higher (for a USB board) - to find out, you look for USB serial device

in the ports section of the Windows Device Manager.

On Linux, it should be /dev/ttyACMx , /dev/ttyUSBx or similar. Once you've selected the

correct serial port and board, press the upload button in the toolbar or select the Upload

item from the Sketch menu. Current Arduino boards will reset automatically and begin the
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upload. With older boards (pre-Diecimila) that lack auto-reset, you'll need to press the

reset button on the board just before starting the upload. On most boards, you'll see the RX

and TX LEDs blink as the sketch is uploaded. The Arduino Software (IDE) will display a

message when the upload is complete, or show an error.

Libraries

Libraries provide extra functionality for use in sketches, e.g. working with hardware or

manipulating data. To use a library in a sketch, select it from the Sketch > Import Library

menu. This will insert one or more #include statements at the top of the sketch and

compile the library with your sketch. Because libraries are uploaded to the board with your

sketch, they increase the amount of space it takes up. If a sketch no longer needs a library,

simply delete its #include statements from the top of your code.

Serial Monitor

This displays serial sent from the Arduino or Genuino board over USB or serial connector.

To send data to the board, enter text and click on the "send" button or press enter. Choose

the baud rate from the drop-down menu that matches the rate passed to Serial.begin in

your sketch. Note that on Windows, Mac or Linux the board will reset (it will rerun your

sketch) when you connect with the serial monitor. Please note that the Serial Monitor does

not process control characters; if your sketch needs a complete management of the serial

communication with control characters, you can use an external terminal program and

connect it to the COM port assigned to your Arduino board.You can also talk to the board

from Processing, Flash, MaxMSP, etc (see the interfacing page for details).

3.12 Proteus Software
The Proteus Design Suite is a proprietary software tool suite used primarily for electronic

design automation. The software is used mainly by electronics design engineers and

technicians to create schematics and electronics prints for manufacturing printed circuit

boards. The first version of what is now the Proteus Design Suite was called PC-B and
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was written by the company chairman, John Jameson, for DOS in 1988. Schematic

Capture support followed in 1990 with a port to the Windows environment shortly

thereafter. Mixed mode SPICE Simulation was first integrated into Proteus in 1996 and

micro-controller simulation then arrived in Proteus in 1998. Shape based auto routing

was added in 2002 and 2006 saw another major product update with 3D Board

Visualization. More recently, a dedicated IDE for simulation was added in 2011 and

MCAD import/export was included in 2015. Support for high speed design was added in

2017. Feature led product releases are typically biannual, while maintenance-based

service packs are released as required.

Figure 3.21: Proteus Software Interface
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CHAPTER 4

METHODOLOGY

4.1 Design And Architecture

The Robot Hardware (Chassis) should be designed such that:

 It should have low weight for a single person to carry during emergencies.

 It should move fast and manoeuvre the entire fire area, at the same time being

stable without losing balance.

 The robot chassis and its structure must accommodate for all the sensors and

micro-controller and should have it suitably covered for protection against fire or

water. We fabricated the chassis using Mild Steel. We decided to use Mild Steel

because of the following reasons:

 Ductile – Mild steel is particularly ductile due to the minimal quantity of carbon

utilised in its production and the lack of any alloying components. Low carbon

steel can be deformed and shaped without losing its hardness, making it an

extremely malleable steel that may be utilised for a variety of applications.

 Machinable and Weldable – Mild steel's ductility makes it particularly well

suited to a variety of steel fabrication techniques, including welding. The smaller

the proportion of carbon in the steel, the more bendable the steel becomes.

 Affordable – Mild steel is a cost-effective type of steel that many steel

fabrication customers utilise to finish their industrial projects because it takes

minimal resources and ingredients.
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Figure 4.1: Structural View ( Side View)

Figure 4.2: Structural View ( Front View)
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4.2 Block Diagram

Figure 4.3: Block Diagram of Our System

4.3 Schematic Diagram

The schematic diagram here is representing the electrical circuit and the components of

the project. Here we have used standardized symbols and lines.

Figure 4.4: Schematic Diagram of the Project
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4.4 Working Principle
The way our 360° Rotating Fire Protection System works is that we take the 220V rms

from the supply voltage and then give it to the SMPS, the SMPS has a step down

transformer inside that stepped that voltage down to 12V DC. Where need 5V then

voltage regulator convert it 5VDC. We feed this voltage to the Arduino Nano Micro-

controller , Arduino Pro mini for it to run. Here we also use Motor driver, 12V SMPS,

High speed pump, NRF receiver, nozzle, servo motor, structural base etc.

In this project one micro-controller work for main circuit, another is use for system

controller. Our system is very useful when there is a fire somewhere but the car cannot

enter that location. With a little manual controller, the system is brought close to the fire

situation and the nozzle is fixed towards the fire and pump will be on, it will spray water.

This system is able to rotate 360 degrees. The system moves forward and backward

according to the signal coming from the controller. The pump can be turned on and off

from a button on the controller. This is the main procedure of our system.

4.5 Our Final System View

Figure 4.5: Our Final System Overview
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Figure 4.6: Our System With Controller
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CHAPTER 5
RESULT AND DISCUSSION

5.1 Discussion
While working on our project, we did face some difficulties as it is a very complex

system but the end results, we came up with were quite satisfactory. We have put the

whole system through several tasks to validate our work and also have taken necessary

notes for future improvements. Some future recommendations that we have involves

improvement in system design and wiring, adding features for more efficient.

5.2 Result
Now, it’s time to talk about the results. We have written our commands using the

Arduino IDE and the following things can happen:

 After power this project then it will be able to operate.

 Then then receiver will control its moving issue.

 When fire create but fire service vehicle will not enter there in this situation our

project able to go there and watered inn fire..

 Our nozzle head portion is 360 degree moveable.

5.3 Advantage
There are many advantages of our project because of its accuracy. Some of the

advantages are pointed out below:

 Reduce accident.

 Targeted water spraying to avoid water damage in office

 Remote controlled operation ensures operator remains safe

 Adjustable Nozzle for Spray Tuning

 Powerful Long Distance Water Spray

 The system is user friendly .
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5.4 Application
This project has applications in many fields due its necessity. We have selected a few of

them and they are given below:

 Useful for controlling indoor fires.

 Can provide a low cost fire protection system with limited centralized fire

protection.
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CHAPTER 6
CONCLUSION

6.1 Conclusion
Fire has always been a devastating phenomenon but the technology advancements it

become easier to tackle it. Firefighters try their best to respond quickly to case of fire and

event put their lives at risk of they endeavour to save human life and protect property from

the fires. Some attempts have been made to automatic fire fighting for the navy (ship

board autonomous fire fighting robot). This paper describes one such solution to the

problem of fire fighting with help of 360 degree fire protection system. In conclusion there

are many possible ways to put out fires but it always safer to use the constantly this idea to

reduce the involvement of fire fighters thereby decreasing the risk of physical injuries and

life threats. Comparing this prototype with the existing technology we implement the

sensor and wireless technology. Nowadays the fire fighting technologies are fully manual.

in scope of future we implement wireless technology to control the fires.

6.2 Future Scope
 In future, we make it more efficient.

 In future, we are thinking about adding more features to the system such as sensor

and monitoring cameras.
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